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Introduction 

 
The Import Tool for FactoryTalk™ allows you to convert a FactoryTalk application into an BLUE Open Studio 
project, and then deploy it on any supported platform. This tool was designed to import tags, screens, alarm 
configuration, and communication settings. After converting applications, you can also edit and enhance them, 
leveraging any native feature of BLUE Open Studio. 
 
This document describes all interfaces supported by the Import Tool for FactoryTalk, as well as its limitations. 
Interfaces that are not explicitly described in this manual may not be supported. When necessary, you can use 
the standard Integrated Development Environment (IDE) from BLUE Open Studio to manually configure any 
interface that is not automatically converted by this tool.  
 
This import wizard is sold as an add-on for BLUE Open Studio, and it requires a license to be enabled. For more 
information, consult your software vendor.  

Also, if you are running BLUE Open Studio on a Windows operating system that has User Account Control (UAC) 
enabled, then you may have problems using this import wizard. Close the application, and then run it again as an 
administrator (i.e., right-click the BLUE Open Studio program icon, and then click Run as administrator on the 
shortcut menu). 

REMARKS:  

 This document describes the known limitations for this tool by the time that this document was 
written. If you identify additional limitations, please report them to your software vendor. 

 If the Import Wizard finds any unexpected property when importing a screen, the whole screen will 
not be converted at all. Therefore, if you experience this behavior, please share the exported files 
from the screens that were not converted with your software vendor, so we can study the feasibility to 
address the limitation in a timely manner. 
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How to convert projects from FactoryTalk ME/SE to BLUE Open Studio 

Export tags from FactoryTalk project 

1. Open FactoryTalk project; 

2. In FactoryTalk View Studio, from the Tools menu, select Tag Import and Export Wizard; 

3. Select Export FactoryTalk View tag database to CSV file; 

4. Follow the instructions in the wizard; 

 

Export graphic displays from FactoryTalk project 

1. Open FactoryTalk project; 

2. In the Explorer windows, right-click the Displays editor or the Global Objects editor; 

3. Select Import and Export; 

4. Follow the instructions in the wizard; 

 

Export alarm files from FactoryTalk ME project 
ALARMS ARE NOT CURRENTLY SUPPORTED BY THE IMPORT WIZARD WHEN USING FactoryTalk ME. 

 

Export alarm files from FactoryTalk SE project 

1. Open FactoryTalk project; 

2. In FactoryTalk View Studio, from the Tools menu, select Tag Import and Export Wizard; 

3. Select Export FactoryTalk View tag database to CSV file; 

4. Select Site Edition on Project Type; 

5. Follow the instructions in the wizard; 

 

Importing files from FactoryTalk project on BLUE Open Studio 

• Open Import Wizard:  

Home > Import Wizard > Import Tool for FactoryTalk™ 
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Options 

Do not import duplicate items: When this option is selected, the following items are not imported in case 
there is already an equivalent in the current project:  

o Tags Database (tags with the same name will not be imported)  

o Screens (screens with the same name will not be imported)  
 
Importing Tag  

Click Browse to select the .csv file exported from FactoryTalk application that you intend to import are 
stored.  
 
Use prefix 

Select this option to specify a prefix that will be prepended to the names of the imported tags. It is useful 
to differentiate the imported tags from the tags created manually. 
 
Importing Screens  

Click Browse to select the .xml file(s) exported from FactoryTalk application that you intend to import are 
stored. This option import the graphical screens (including their objects and animations) to BLUE Open Studio. 

Note: Check the User Manual to know which objects are supported. 
 

Importing Alarm configuration 
Click Browse to select the .csv (SE Projects) file exported from FactoryTalk application that you intend to 

import are stored. Alarm configuration from FactoryTalk ME (*.xml files) are not supported by the Import Wizard. 
 

FactoryTalk Application Folder 
Click Browse to select the directory where the FactoryTalk application are stored.  
Note: If don’t specify the application folder, images and parameters files will not be imported. 
 

Importing Drivers  
Check this option to import the driver configuration to BLUE Open Studio.  
Note: Tags will be automatically replaced. 



 Import Wizard Tool for FactoryTalk™ ME/SE – Rev. D 
 

Page 7/83 

 

 
Configuration… 

Figure 2. Devices configuration list 
 

 
 

Devices  
Shows the list of configured devices. 

 
 
Add…  

Figure 3. Device configuration 
 

 
• Device Name: Specify device name exactly as it is in the FactoryTalk application.  

• Driver: Select communication driver. 

• Station: Type the device station of the PLC. The station syntax depends on the option selected 
on the Driver combo-box. Please consult the respective driver manual for more details. 
 
 

Edit…  
Edit device from the list of configured devices. 

  
 

Remove 
Remove device from the List of configured devices. 
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Importing Tag  
After configuring the settings in this dialog, click Next. 

 
 
The fields and settings that are common for all data Source Types include the following:  

• Grid: Displays the list of tags found on the data source.  

o checkbox: Check to import the tag from the data source to the Tags Database of the current 
project.  

o TagName: Name of the tag  

o Size: Array size of the tag  

o Type: Data type of the tag (Boolean, Integer, Real, String or Class:<ClassName>)  

o Description: Description of the tag  

• Check button: Click to select/import all tags in the grid  

• Uncheck button: Click to uncheck all tags in the grid  

• Filter button: Click to filter the tags. The Filter dialog will display, allowing you to specify a mask for each 
column in the grid. Wild cards (* and ?) can be used to filter data.  

• Clear Filter button: Click to reset the filter.  

• Import Filtered Tags Only checkbox: Check this option to import only the tags that are visible in the grid 
(filtered).  

• Status box: Displays a message describing the status of the tag currently selected in the grid. This 
information is especially useful to indicate why a tag cannot be imported.  

• Legend box: Describes the meaning of the colors that represent tag status:  
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o (Red) Error:Tag cannot be imported because it is not supported by BLUE Open Studio. See the 
Status box for a detailed description of the error.  

o (Blue) Tag will be imported:Tag will be imported after you click the Finish button.  

o (Gray) Tag can be imported:Tag can be imported but it has not been checked.  

• Database size box: Displays summary information regarding the current Import Wizard:  

o Current: Indicates the number of tags configured in the Project Tags database of the current 
project  

o Importing: Indicates the number of tags selected to be imported  

o Replacing: Indicates the number of tags configured in the Project Tags database of the current 
project that will be replaced by an imported tag with the same name.  

After selecting the tags to import, click the Finish button, or click Cancel to abort the operation. 
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Graphical Interface – Displays and Objects 

This chapter describes the features supported when converting screens from FactoryTalk ME/SE to BLUE Open 
Studio, as well as the limitations. 

Object Property Status Remarks 

Display Settings (ME) 

 

Display 
Type 

Replace S  

On Top S  

Cannot Be Replaced N  

Display Number N  

Security Code N  

Title Bar S  

Disable Initial Input Focus N  

Maximum Tag Update Rate N  

Size 
Use Current Size S  

Specify Size in 
Pixels S  

Position 
X S  

Y S  

Background Color > Color S  

Background Color S  

Display Settings (SE) 

 

Display 
Type 

Replace S  

Overlay N  

On Top S  

Allow Multiple Running Copies N  

Cache After Displaying N  

Title Bar S  

System Menu S  

Minimize Button S  

Maximize Button S  

Size to Main Windows at Runtime N  

Show Last Acquired Value N  

Maximum Tag Update Rate N  
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Object Property Status Remarks 

Size 
Use Current Size S  

Specify Size in 
Pixels S  

Resize 
Allow Display to be 

Resized N  

When Resized N  

Position 

Use Current 
Position S  

X S  

Y S  

Security Code N  

Background Color > Color S  

Background Color S  

Track Screen for Navigation N  

Navigation History Screen Name N  

Text (ME/SE) 

 
General 

Text S  

Back Color S  

Fore Color S  

Size to fit L Always checked. 

Word wrap N  

Size S  

Alignment L MiddleLeft, Center and MiddleRight 
only. 

Insert Variable > 
Numeric > Tag S  

Insert Variable > 
Numeric > Literal 

number 
S  

Insert Variable > 
Numeric > Number 

of digits 
S  

Insert Variable > 
Numeric > Decimal 

places 
S  
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Object Property Status Remarks 

Insert Variable > 
Numeric > Fill left 

with 
N  

Insert Variable > 
String > Tag S  

Insert Variable > 
String > Literal 

string 
S  

Insert Variable > 
String > Fixed 

number of 
characters 

S  

Insert Variable > 
String > Right-most 
characters in string 

are displayed 
N  

Insert Variable > 
String > Show * 

character if string is 
longer than field 

width 

N  

Insert Variable > 
Time/Date S  

Back style S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Image (ME/SE) 

 

General 

Image S 
Image file only be imported if 

specified FactoryTalk application 
path on import wizard. 

Image color N  

Image back color N  

Image blink N  

Image back style S  

Common 
Size > Height S  

Size > Width S  
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Object Property Status Remarks 

Position > Top S  

Position > Left S  

Other N  

Panel (ME/SE) 

General 

Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Border width S  

Back style S  

Pattern style N  

Border uses back 
color S  

Pattern color N  

Back color S  

Border color L Only exports with line border. 

Blink N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Arc (ME/SE) 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  
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Object Property Status Remarks 

Position > Left S  

Other N  

Ellipse (ME/SE) 

 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Freehand (ME/SE) 

 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Line (ME/SE) 

 
General 

Line style L None, Solid and Dash only. 

Back style S  

Fore color S  
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Object Property Status Remarks 

Back color S  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Polygon (ME/SE) 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Polyline (ME/SE) 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  
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Object Property Status Remarks 

Position > Left S  

Other N  

Rectangle (ME/SE) 

 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Rounded Rectangle 
(ME/SE) 

 

General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Wedge (ME/SE) 

 
General 

Line style L None, Solid and Dash only. 

Back style S  

Pattern style N  
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Object Property Status Remarks 

Fore color S  

Back color S  

Pattern color N  

Line width S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Button (SE) 

 

General > Style N  

Other 

Capture cursor N  

Highlight when 
object has focus N  

Tab Index N  

Action 

Action > Set tag to 1 L Confirm Action not supported. 

Action > Set tag to 0 L Confirm Action not supported. 

Action > Toggle tag 
value S  

Action > Set tag to 1 
on press and to 0 

on release 
S  

Action > Set tag to 0 
on press and to 1 

on release 
S  

Run Command L 

Confirm Action and Repeat rate 
(secs) not supported. 

(Check the list of commands 
supported) 

Up 
Appearanc

e 

General > Back 
style S  

General > Pattern 
style N  

General > Fore 
color S  
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Object Property Status Remarks 

General > Back 
color S  

General > Pattern 
color N  

Caption > Font S  

Caption > Size S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption >  Insert 
Variable > Numeric 

> Tag 
S  

Caption >  Insert 
Variable > Numeric 

> Literal number 
S  

Caption >  Insert 
Variable > Numeric 
> Number of digits 

S  

Caption >  Insert 
Variable > Numeric 
> Decimal places 

S  

Caption >  Insert 
Variable > Numeric 

> Fill left with 
N  

Caption >  Insert 
Variable > String > 

Tag 
S  

Caption >  Insert 
Variable > String > 

Literal string 
S  

Caption >  Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption >  Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption >  Insert 
Variable > String > 

N  
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Object Property Status Remarks 
Show * character if 

string is longer than 
field width 

Caption >  Insert 
Variable > 
Time/Date 

S  

Image settings > No 
image S  

Image settings > 
Use image 
reference 

S  

Image settings > 
Import file N  

Image settings > 
Scale image S  

Down Appearance N  

Disabled Appearance N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Momentary Push Button 
(ME/SE) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > 
Highlight color N  
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Object Property Status Remarks 

Button settings > 
Button action S  

Button settings > 
Hold time S  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 

Select state S  

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  
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Object Property Status Remarks 

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Common Size > Height S  
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Object Property Status Remarks 

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Indicator S  

Maintained Push Button 
(ME/SE) 

General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > 
Highlight color N  

State settings > 
Next state based on L Current State only. 

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 

Select state S  

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  
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Object Property Status Remarks 

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  
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Object Property Status Remarks 

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Indicator S  

Latched Push Button 
(ME/SE) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  
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Appearance > 
Border Uses Back 

Color 
S  

Appearance > 
Highlight color N  

Button settings > 
Latch reset type S  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 

Select state S  

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  
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Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  
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Image settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Indicator S  

Handshake S  

Multistate Push Button 
(ME/SE) 

General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > 
Highlight color N  

State settings > 
Number of states S  

State settings > 
Next state based on L Current State only. 

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 
Select state S  

General > Value S  
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General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  
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Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Timing Auto Repeat setting N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Indicator S  

Interlocked Push Button 
(ME/SE) General Appearance > 

Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 
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Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > 
Highlight color N  

Button Value S  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 

Select state L 
It is imported first state only, BLUE 
Open Studio works with only one 

state. 

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  
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Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  



Import Wizard Tool for FactoryTalk™ ME/SE – Rev. D 

Page 32/83 

 

Object Property Status Remarks 

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Value S  

Ramp Button (ME/SE) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color S  

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  
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Appearance > Blink N  

Button settings > 
Use variable 

lower/upper Limit 
S  

Button settings > 
Use variable ramp 

value 
S  

Button settings > 
Ramp up S  

Button settings > 
Ramp down S  

Button settings > 
Upper Limit S  

Button settings > 
Ramp value S  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > audio S  

States 

Select state L 
It is imported first state only, BLUE 
Open Studio works with only one 

state. 

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  
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Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  
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Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Ramp S  

Limit S  

Numeric Display (ME) General 

Appearance > 
Border Style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 
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Appearance > 
Pattern color N  

Appearance > Fore 
color N  

Appearance > Blink N  

Text > Font S  

Text > Size S  

Text > B S  

Text > I S  

Text > U S  

Text > Alignment S  

Value settings > 
Number of digits N  

Value settings > Fill 
left with N  

Value settings > 
Decimal places S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Polarity S  

Numeric Display (SE) General 

Expression S  

Show Digit 
Grouping N  

Field Length S  

Decimal Places N  

Format > Decimal S  

Format > 
Hexadecimal S  
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Format > Octal N  

Format > Binary S  

Format > Floating 
Point N  

Overflow N  

Leading Character N  

Justification S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Numeric Input Enable 
(ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  
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Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio N  

Other > Key 
navigation N  

Other > Take focus 
on press N  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  
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Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  
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Numeric 

Pop-up settings > 
Numeric pop-up N  

Min/max range and 
ramp settings > 
Minimum value 

S  

Min/max range and 
ramp settings > 
Maximum value 

S  

Min/max range and 
ramp settings > 

Ramp value 
N  

Min/max range and 
ramp settings > Use 

variable 
minimum/maximum 

S  

Decimal point 
settings > Decimal 

point 
N  

Decimal point 
settings > Fixed 
position output 

N  

Decimal point 
settings > Digits 

after decimal 
N  

Timing Timing and 
handshake settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Optional Exp N  

Enter N  

Enter Handshake N  

Minimum S  

Maximum S  
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Numeric Input (SE) 

General 

Tag S  

Tab index N  

Default data N  

Field length N  

Decimal places N  

Format > Decimal S  

Format > 
Hexadecimal S  

Format > Octal N  

Format > Binary S  

Format > Floating 
Point N  

Overflow N  

Justification N  

Leading Character N  

Display On-screen 
Keyboard N  

Security N  

Continuosly update N  

Discard input and 
resume updating 

when focus is lost 
N  

Confirm Numeric 
Entry N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Minimum S  

Maximum S  
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Navigation Button (SE)   N Object not supported. 

Numeric Input Cursor 
Point (ME)   N Object not supported. 

String Display (ME) General 

Appearance > 
Border Style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  

Appearance > Fore 
color N  

Appearance > Blink N  

Text > Font S  

Text > Size S  

Text > B S  

Text > I S  

Text > U S  

Text > Alignment S  

Value settings > 
Number of digits N  

Value settings > Fill 
left with N  
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Value settings > 
Decimal places S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Value S  

String Display (SE) 

General 

Expression S  

Dimensions > Width S  

Dimensions > 
Height S  

Character > Offset N  

Character > 
Justification S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

String Input Enable (ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  
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Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio N  

Other > Key 
navigation N  

Other > Take focus 
on press N  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  
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Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 
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Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  

String 

Pop-up settings > 
String pop-up N  

Pop-up settings > 
Fill character N  

Pop-up settings > 
Number of input 

characters 
N  

Pop-up settings > 
Fill character N  

Pop-up settings > 
Mask scratchpad N  

Timing Timing and 
handshake settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Enter N  

Enter Handshake N  

String Input (SE) General 

Tag S  

Tab index N  

Default data N  

Dimensions > Width S  
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Dimensions > 
Height S  

Justification > Left S  

Justification > 
Center S  

Justification > Right S  

Display On-screen 
Keyboard N  

Security N  

Continuously N  

Discard input and 
resume updating 

when focus is lost 
N  

Confirm String 
Entry N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Goto Display Button 
(ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  
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Appearance > Back 
color S  

Appearance > 
Border color S  

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Display settings > 
Display S  

Display settings > 
Parameter file S  

Display settings > 
Parameter list S  

Display settings > 
Display position N  

Display settings > 
Use Variable 

Display Position 
S  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio S  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  
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Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  



Import Wizard Tool for FactoryTalk™ ME/SE – Rev. D 

Page 50/83 

 

Object Property Status Remarks 

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Display Name S  

Top Position N  

Left Position N  

Return to Display (ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  
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Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio S  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  
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Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  
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Object Property Status Remarks 

Image settings > 
Alignment N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Close Display (ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color S  

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Value > Write on 
close N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  
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Object Property Status Remarks 

Other > Audio S  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
N  
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Object Property Status Remarks 
characters in string 

are displayed 

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Value S  

List Display Selector 
(ME)   N Object not supported. 
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Object Property Status Remarks 

Multistate Indicator 
(ME/SE) 

General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Border Uses Back 

Color 
S  

State settings > 
Number of states S  

State settings > 
Trigger type L Value only. 

States 

Select state S  

General > Value S  

General > Back 
color S  

General > Border 
color L Only exports with line border. 

General > Blink N  

General > Pattern 
Style N  

General > Pattern 
color N  

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  
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Object Property Status Remarks 

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  
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Object Property Status Remarks 

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Indicator S  

Symbol (ME/SE)  N Object not supported. 

List Indicator (ME/SE)  N Object not supported. 

Bar Graph (ME/SE) 

General 

Appearance > 
Border Style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Border width S  

Appearance > Fill 
style S  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > Fill 
color S  

Bar graph 
settings 

Minimum value S  

Maximum value S  

Fill direction S  
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Object Property Status Remarks 

Thresholds  N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Value S  

Gauge (ME/SE) 

General  N Object is imported as Gauge BLUE 
Open Studio’s symbol. 

Display 

Value settings > 
Minimum value S  

Value settings > 
Maximum value S  

Legend settings N  

Threshold settings N  

Common 

Size > Height N  

Size > Width N  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns Value S  

Scale (ME/SE) Appearanc
e 

Border style L None only. 

Line style L None, Solid and Dash only. 

Back style L Transparent only. 

Border width N  

Line width S  

Border uses back 
color N  

Back color N  

Border color N  
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Object Property Status Remarks 

Fore color S  

Blink N  

Scale 
Setup 

Tick direction S  

Major ticks S  

Minor ticks S  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Pause Trend Button 
(ME)   N Object not supported. 

Next Pen Button (ME)   N Object not supported. 

Trend (ME/SE)   N Object not supported. 

Key Buttons (ME/SE) – 
Backspace, End, Enter, 
Home, Move Left, Move 

Right, Move Down, Move 
up, Page Down, Page up 

General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  
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Object Property Status Remarks 

Appearance > 
Highlight color N  

Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio S  

Other > Send press 
to > Object With 

Focus 
S  

Other > Send press 
to > Linked Object N  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  



Import Wizard Tool for FactoryTalk™ ME/SE – Rev. D 

Page 62/83 

 

Object Property Status Remarks 

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  
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Object Property Status Remarks 

Image settings > 
Alignment N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Connectio
ns 

Value S  

Optional Exp N  

Enter N  

Enter Handshake N  

Minimum S  

Maximum S  

Control List Selector 
(ME/SE)   N Object not supported. 

Pilot Control List 
Selector (ME/SE)   N Object not supported. 

Local Message Display 
(ME/SE)   N Object not supported. (Future 

Release) 

Login Button (ME)   N Object not supported. (Future 
Release) 

Logout Button (ME)   N Object not supported. (Future 
Release) 

Password Button (ME)   N Object not supported. (Future 
Release) 

Macro Button (ME)   N Object not supported. 

Print Button (ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 
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Object Property Status Remarks 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio S  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  
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Object Property Status Remarks 

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 



Import Wizard Tool for FactoryTalk™ ME/SE – Rev. D 

Page 66/83 

 

Object Property Status Remarks 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  

Common 

Size > Height S  

Size > Width S  

Position > Top S  

Position > Left S  

Other N  

Shutdown Button (ME) General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Shape L Rectangle only. 

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color L Only exports with line border. 

Appearance > 
Pattern color N  
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Object Property Status Remarks 

Appearance > 
Highlight color N  

Appearance > Blink N  

Touch margins > 
Horizontal margin N  

Touch margins > 
Vertical margin N  

Other > Audio S  

Label 

Caption > Font S  

Caption > Caption 
color S  

Caption > Caption 
back color N  

Caption > Caption 
blink N  

Caption > Word 
wrap S  

Caption > Size S  

Caption > 
Alignment S  

Caption > Insert 
Variable > Numeric 

> Tag 
S  

Caption > Insert 
Variable > Numeric 

> Literal number 
S  

Caption > Insert 
Variable > Numeric 
> Number of digits 

S  

Caption > Insert 
Variable > Numeric 
> Decimal places 

S  

Caption > Insert 
Variable > Numeric 

> Fill left with 
N  

Caption > Insert 
Variable > String > 

Tag 
S  
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Object Property Status Remarks 

Caption > Insert 
Variable > String > 

Literal string 
S  

Caption > Insert 
Variable > String > 
Fixed number of 

characters 
S  

Caption > Insert 
Variable > String > 

Right-most 
characters in string 

are displayed 

N  

Caption > Insert 
Variable > String > 
Show * character if 

string is longer than 
field width 

N  

Caption > Insert 
Variable > 
Time/Date 

S  

Caption > B S  

Caption >  I S  

Caption >  U S  

Caption > Caption 
backstyle N  

Image settings > 
Image L 

Image file only be imported if 
specified FactoryTalk application 

path on import wizard. 

Image settings > 
Image color N  

Image settings > 
Image blink N  

Image settings > 
Image scaled L Always enabled 

Image settings > 
Image back style S  

Image settings > 
Alignment N  

Common 
Size > Height S  

Size > Width S  
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Object Property Status Remarks 

Position > Top S  

Position > Left S  

Other N  

Time Date Display 
(ME/SE) 

General 

Appearance > 
Border style L 

Inset will be imported as Sunken 
on BLUE Open Studio. 

RaisedInset will be imported as 
Etched on BLUE Open Studio. 

Appearance > Back 
style S  

Appearance > 
Border width S  

Appearance > 
Pattern style N  

Appearance > 
Border Uses Back 

Color 
S  

Appearance > Back 
color S  

Appearance > 
Border color S  

Appearance > 
Pattern color N  

Appearance > 
Highlight color N  

Appearance > Blink N  

Text > Font S  

Text > Size S  

Text > B S  

Text > I S  

Text > U S  

Text > Alignment S  

Time and 
date format  S  

Common 
Size > Height S  

Size > Width S  
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Object Property Status Remarks 

Position > Top S  

Position > Left S  

Other N  

ActiveX Control (ME/SE)  N Object not supported. 

RecipePlus Button 
(ME/SE)  N Object not supported. 

RecipePlus Selector 
(ME/SE)  N Object not supported. 

RecipePlus Table 
(ME/SE)  N Object not supported. 

Recipe (SE)  N Object not supported. 

Language Switch Button 
(ME)  N Object not supported. 

Symbol Factory (ME/SE)  S Supported. 

S:Supported; N:Not Supported; L:Supported with Limitations 
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Graphical Interface – Animations 

This chapter describes the features supported when converting screens object animations from FactoryTalk 
ME/SE to BLUE Open Studio, as well as the limitations. 
 

Category Type Status Remarks 

Visibility (ME/SE) 

Expression S  

Tags S  

Expression… S  

Expression true state L Always visible. 

Color (ME/SE) 

Expression S  

Tags S  

Expression… S  

Value S  

Line N  

Fill S  

Fill Style L 
Shaded not supported. 

FactoryTalk don’t exports Gradient. 

Blink L The second color is always the object. 

Blink rate (Seconds) L 
BLUE Open Studio accepts only slow and 
fast, (values >= 1) = fast and (values < 1) = 
slow 

Horizontal/Vertical 
Position (ME/SE) 

Expression S  

Tags S  

Expression… S  

Expression range > Use 
tag’s min and max 

property values 
L Export only value min and max at the 

moment. 

Expression range > Use 
constant S  

Expression range > 
Read from tags N  

Vertical offset (Pixels) S  

Height / Width (ME/SE) 
Expression S  

Tags S  
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Category Type Status Remarks 

Expression… S  

Expression range > Use 
tag’s min and max 

property values 
L Export only value min and max at the 

moment. 

Expression range > Use 
constant S  

Expression range > 
Read from tags N  

Vertical change 
(Percent) S  

Anchor S  

Fill (ME/SE) 

Expression S  

Tags S  

Expression… S  

Expression range > Use 
tag’s min and max 

property values 
L Export only value min and max at the 

moment. 

Expression range > Use 
constant S  

Expression range > 
Read from tags N  

Fill (Percent) S  

Fill Direction S  

Inside Only L Checked only. 

Rotation (ME/SE) 

Expression S  

Tags S  

Expression… S  

Expression range > Use 
tag’s min and max 

property values 
L Export only value min and max at the 

moment. 

Expression range > Use 
constant S  

Expression range > 
Read from tags N  

Rotation (Degrees) S  
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Category Type Status Remarks 

Center of rotation L LeftTop, LeftBottom, Center, RightTop and 
RightBottom only. 

Note: Rotation support only Line, Polygon and Polyline 

Horizontal/Vertical Slider 
(ME/SE) 

Expression S  

Tags S  

Expression… S  

Expression range > Use 
tag’s min and max 

property values 
L Export only value min and max at the 

moment. 

Expression range > Use 
constant S  

Expression range > 
Read from tags N  

Horizontal/Vertical 
offset (Pixels) S  

Touch (ME/SE)  N Not supported. 

OLE Verb (ME/SE)  N Not supported. 

S:Supported; N:Not Supported; L:Supported with Limitations 
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COMMANDS (SE) 

This chapter describes commands supported when converting applications from FactoryTalk SE to BLUE Open 
Studio, as well as the limitations. 

Commands not supported will be imported with the following syntax: 

//COMMAND_NOT_SUPPORTED: <Command_Name>” 

For example: 

//COMMAND_NOT_SUPPORTED: AppAbort” 

Therefore, you can use the Global Find tool to look for the //COMMAND_NOT_SUPPORTED text and manually 
edit each instance that is not automatically supported. 
 

Category Type Command Status Remarks 

System 

Tag and 
Database 

= S  

Ramp S  

Set S  

Toggle S  

External 
Applications 

AppAbort N  

AppActive N  

AppStart S  

DDEExecute N  

OpenRSLogix5000 N  

Multimedia 
Beep N  

PlayWave N  

Framework 

Define N  

Help N  

Pause N  

PrintDisplay N  

ScreenPrint N  

SendKeys N  

Undefine N  

Languages Language N  

Security Login S  
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Category Type Command Status Remarks 

Logout S  

Password S  

Activity Log Remark S  

Graphics 

Navigation 

Abort S  

Display L File, /X, /Y, /H, /W, /P and /T 
only. 

DisplayNavigationHistor
y N  

DisplayNextScreen N  

DisplayPreviousScreen N  

NextWindow N  

PrevWindow N  

PullForward S  

PushBack N  

SetFocus N  

Cache FlushCache N  

Object 
Methods Invoke N  

Cursor 
Movement 

NextPosition N  

Position N  

PrevPosition N  

Recipe 
Management 

Download N  

DownloadAll N  

RecipeRestore N  

RecipeSave N  

Upload N  

UploadAll N  

Alarms 

Acknowledge S  

AcknowledgeAll N  

AlarmAcceptEdits N  

AlarmEvent N  
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Category Type Command Status Remarks 

AlarmLogNewFile N  

AlarmLogOff N  

AlarmLogOn N  

AlarmLogRemark N  

AlarmLogSendToOdbc N  

AlarmOff N  

AlarmOn N  

AlarmPrintOff N  

AlarmPrintOn N  

HandshakeOff N  

HandshakeOn N  

Identify N  

Silence N  

SilenceAll N  

SuppressOff N  

SuppressOffAll N  

SuppressOn N  

Data Log 

DataLogChangeRate N  

DataLogMergeToPrimary N  

DataLogNewFile N  

DataLogOff N  

DataLogOn N  

DataLogRenameFile N  

DataLogSnapshot N  

DataLogSwitchBack N  

Logic and Control 

Derived Tags 
DerivedOff N  

DerivedOn N  

DisplayClient 
DisplayClientClose N  

DisplayClientOpen N  
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Category Type Command Status Remarks 

Events 
EventOff N  

EventOn N  

Flow Control If S  

Client Keys Key N  

Macro N  

S:Supported; N:Not Supported; L:Supported with Limitations 
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EXPRESSIONS (ME/SE) 

This chapter describes expressions supported when converting applications from FactoryTalk ME/SE to BLUE 
Open Studio, as well as the limitations. 
 

Category Expression Status Remarks 

If 

If S  

Then S  

Else S  

Logical 

AND or && S  

OR or || S  

NOT S  

Relational 

< or LT S  

<= or LE S  

> or GT S  

>= or GE S  

<> or NE S  

== or EQ S  

Arithmetic 

+ or Plus S  

- or Minus S  

/ or Divide S  

* or  Multiply S  

% or Modulus S  

** or Exponent S  

Bitwise 

& or AND S  

| or OR S  

^ or XOR S  

>> or Right Shift S  

<< or Left Shift S  

~ or Complement S  

Functions Math 
Arccos S  

Arccosd S  
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Category Expression Status Remarks 

Arcsin S  

Arcsind S  

Arctan S  

Arctand S  

Cos S  

Cosd S  

Log S  

Log10 S  

Sin S  

Sind S  

Sqrt S  

Tan S  

Tand S  

Security 
CurrentUserHasCode N  

CurrentUserName N  

Language Current Language N  

Tags  S Supported. 

S:Supported; N:Not Supported; L:Supported with Limitations 
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Alarms 

This chapter describes the alarm types supported when converting applications from FactoryTalk SE to BLUE 
Open Studio, as well as the limitations. Alarms configured on FactoryTalk ME are not converted to BLUE Open 
Studio. 

Category Condition Status Remarks 

Alarm (ME)  N Not supported. 

Alarm (SE) 

Digital 
Alarm 

Alarm States > Alarm Type > 
On S  

Alarm States > Alarm Type > 
Off S  

Alarm States > Alarm Type > 
Any Change N  

Alarm States > Alarm Type > 
Changes to On N  

Alarm States > Alarm Type > 
Changes to Off N  

Alarm States > Alarm Label S  

Alarm States > Severity N  

Alarm States > In Alarm 
Messages > System Defaults N  

Alarm States > In Alarm 
Messages > User Defaults N  

Alarm States > In Alarm 
Messages > Custom Message S  

Alarm States > In Alarm 
Messages > File N  

Alarm States > In Alarm 
Messages > Printer S  

Alarm Messages N  

Advanced N  

Analog 
Alarm 

Alarm Thresholds > Select 
Threshold L 

Accept 4 threshold only. 

Increasing: Will be 
imported 4 threshold that 
contain most severity, 
case severities are equal 
will be imported the 
element with most value. 
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Category Condition Status Remarks 

Decreasing: Will be 
imported 4 threshold that 
contain most severity, 
case severities are equal 
will be imported the 
element with less value. 

Alarm Thresholds > 
Threshold S  

Alarm Thresholds > Alarm 
Label S  

Alarm Thresholds > Severity S  

Alarm Thresholds > In Alarm 
Messages > System Defaults N  

Alarm Thresholds > In Alarm 
Messages > User Defaults N  

Alarm Thresholds > In Alarm 
Messages > Custom Message S  

Alarm Thresholds > In Alarm 
Messages > File N  

Alarm Thresholds > In Alarm 
Messages > Printer S  

Alarm Messages N  

Advanced N  

    

S:Supported; N:Not Supported; L:Supported with Limitations 
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Communication Interface 

When importing applications from FactoryTalk SE/ME projects, the communication interface can be converted 
using the following drivers from BLUE Open Studio: 
 

Driver Name Manufacturer Device Interface Protocol 
ABCIP Allen-Bradley ControlLogix,MicroLogix Ethernet Ethernet/IP (CIP) 
ABTCP Allen-Bradley PLC2, PLC5, SLC500 Ethernet DF1 
ABKE Allen-Bradley PLC2, PLC5, SLC500 Serial DF1 
ABENI Allen-Bradley PLC2, PLC5, SLC500 Ethernet to Serial DF1 

 
Look at the chapter “How to convert projects from FactoryTalk ME/SE to BLUE Open Studio” for instructions on 
how to link BLUE Open Studio drivers to Device Names on the FactoryTalk ME/SE application. 
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TIPS AND TRICKS 

Startup Screen 

       Checking startup screen on FactoryTalk View 

1. Open FactoryTalk project; 

2. In the Explorer windows, right-click the Startup editor or the Global Objects editor; 

3. The statup dialog opens; 

4. Initial graphic field contains the startup screen. 

 

      Specifying the startup screen on BLUE Open Studio 

1. On the Project tab of the ribbon, in the Settings group, click Viewer. The Project Settings dialog is 
displayed with the Viewer tab selected.  

2. In the Startup screen box, type main.scr. When you run the project, it will automatically display the main 
screen (or whichever screen you specify) first. You can specify a screen before you create it, but if the 
screen has been created, then you can also select it from the list.  

3. Click OK.  
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